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Synopsis
In the first part of this paper, we provide an example of a project designed to
foster mathematical creativity among students at an independent, all-girls school
in the Northeastern United States. The mathematical motivator for the project
is a polyomino proof by induction first formulated by Solomon Golomb. We
explain how the project has been implemented over the past two years at the
school’s Innovation Lab in collaborative work between a mathematics instructor
and an educational technologist, provide instructions and background information
to facilitate the implementation of this project at other learning sites, and show
examples of student work along with a discussion of their reactions and takeaways.
We close by naming the practice of “mathematical code switching” and situate it
within Rochelle Gutiérrez’s discussion of creative insubordination in mathematics
teaching.
Keywords: creativity, innovation, mathematical code switching, STEM education, educational technology

1. INTRODUCTION
This article represents the collaboration across two years by its authors —
a mathematics instructor and an educational technologist — as we sought
to incorporate a project that would promote creativity at the beginning of a
Journal of Humanistic Mathematics

Volume 10 Number 2 (July 2020)

Benjamin Dickman and Erik Nauman

259

high school math course. We open here with a few frequently asked questions
about creativity, discuss the project we have designed along with student
results/reactions and how it can be implemented at other learning sites,
and close by introducing the idea of mathematical code switching as situated
within Gutiérrez’s research on creative insubordination [17].

Figure 1: A student-created 8 × 8 L-tromino board with one L-tromino.

Frequently Asked Questions on Fostering Creativity
The question of how to foster creativity among (mathematics) learners is
difficult to answer for a variety of reasons, which range from pedagogical
to philosophical to pragmatic to pedantic. Here are a few of the responses
we have encountered in discussions around how to engage with mathematics
learners in ways that promote creativity.
1. What does creativity mean?
2. Where can I find materials that will make my students more creative?
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3. I have heard about some possible ways to engage students mathematically — maybe even creatively — but I am worried that they would be
frowned upon since they do not connect with the ways that others (e.g.,
administrators, parents/guardians/caretakers) think about math.
4. How can I measure creativity to find out if my students are really
becoming more creative?
5. What can I do if I am not a creative teacher, a creative mathematician,
or even a creative person?
In this article, we will give our answer to the first question by articulating a
definition for creativity; we will respond to the second question by providing
and discussing materials used in a high school course as a three day project
co-led by the authors (a mathematics instructor and an educational technologist); and we will discuss strategies for the third question: in particular, by
naming the practice of mathematical code switching. We will not give direct
answers to the fourth or fifth question, but have included them here due to
the frequency with which they arise. Bearing that in mind, let us open with
a few remarks about these questions — one on measuring creativity and the
other on being, or not being, creative — before moving on.
Creativity Beyond Individuals
The study of creativity is often traced back to Guilford’s APA presidential address [16], in which the goal was to identify and measure the traits
that characterize a creative individual. This approach was consonant with
Guilford’s earlier psychometric work assessing military personnel (e.g., [15]).
Subsequent investigations of creativity have proceeded in other ways; for example, Rhodes introduced his 4P framework around whether creativity is
placed in a person, process, procedure, or (environmental) press [26]. An
additional dimension that has emerged over time has been the distinction
between Big-C Creativity and little-c creativity, which refers to the notion
that creativity can be thought about as existing across a continuum from
eminent to everyday [21]. Other studies have explored such topics as the
collaborative emergence of creativity among groups of individuals [30], identifying creativity with problem solving (e.g., [38]) or problem finding (e.g.,
[11]; for problem posing in mathematics, see, e.g., [33, 39, 8]); and challenges to uniformly positive views by discussing the dark side of creativity [6].
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More generally, Sawyer remarks succinctly that “defining creativity may be
one of the most difficult tasks facing the social sciences” [31, page 11]). In
our project, we avoid the 4P framework and the Big-C to little-c continuum; in particular, we present a conception of creativity that does not locate
creativity within people: in this way, the question of measuring a student’s
creativity, and the consideration of what to do if educators do not believe
themselves to be creative, are both rendered moot. Although we intend to
make a case for why this mathematical activity reflects participation in creativity, we nevertheless encourage readers to reflect on why so many have the
knee-jerk reaction to ask of creativity how it can be measured or evaluated
through some standardized metric (for more, cf. e.g., [2, page 452]).
Working Definition of Creativity
Our goal in this article will be to situate creativity within a participatory
model (cf. [19, 20]). In particular, our own working definition of creativity is
as follows.
Creativity: Purposeful work that is novel and valued within a
domain/area, which emerges over time through the participation
of many actors in many roles.
For remarks on the meaning of purpose and how it evolves in the context
of creativity studies, we refer the reader to Gruber and collaborators (e.g.,
[13, 14]). Salient to our definition is that we shift from the adjective ‘creative’
to the noun ‘creativity’, such that we choose not to apply the former to some
object but rather to encourage participation in the latter. Thus, we speak
of ‘participating in creativity’, and intend to discuss concretely how we have
aimed to do so with our students in their mathematical studies.
2. INDUCTION IN THE MATHEMATICS CLASSROOM
The mathematics covered in our course consists of an introduction to proof by
the principle of mathematical induction (PMI) as taught in an all-girls school
in the Northeastern United States. The course title is Problem Solving &
Problem Posing; the class has a pre/corequisite of Calculus; its structure is to
cover a variety of mathematical topics outside of Calculus (e.g., proof-writing,
graph theory, combinatorics, elementary group theory, number theory) and to
facilitate students’ grasp of resources to call upon when facing a non-routine
problem (e.g., [25, 32]) as well as how to pose problems of their own (e.g., [4]).
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Figure 2: Two student-created 8 × 8 L-tromino boards.

The principal goal of this course is for students to expand their conception
of mathematics beyond solving equations or measuring angles, and to view
themselves as generative contributors to mathematics who are capable of
novel (i.e., new to them) and valuable (i.e., valued by them) ideas. As we
are primarily concerned with students’ own self-assessments of novelty and
value — rather than assessments from peers, experts, or gatekeepers from a
larger field — the result is a form of creativity outside of the Big-C to little-c
continuum (although connected to mini-c creativity, cf. [3]).
Tackling Problems Pre- and Post-PMI
PMI is introduced in our classroom as a method to prove statements about
the natural numbers, and we begin with students by verifying past assertions
that were either proved using alternative approaches or investigated with
conjectures.
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We include below two statements that we explored without PMI and then
proved with PMI; brief summary accounts are provided for the former, and
succinct proofs are provided for the latter.
Example 1:. The sum of the first n natural numbers is n(n + 1)/2.
Exploration without PMI:. We used a geometric representation to show that
the sum of the first n odd numbers is n2 ; next, we observed that summing
the first n evens can be done by adding 1 to each of the first n odds, thereby
adding an additional n for a total of n2 + n = n(n + 1). Finally, we observed
that the first n natural numbers can be summed by taking the evens’ sum
and dividing by 2, which gave us the desired formula of n(n + 1)/2.
Proof with PMI:. The formula holds for n = 1 since 1 = 1(1+1)/2. Assuming
the formula holds for the first k naturals, observe that adding k + 1 gives
k(k + 1)/2 + (k + 1) = (k + 1)((k + 1) + 1)/2. QED.
Example 2:. The sum of the first n perfect squares is n(n + 1)(2n + 1)/6.
Exploration without PMI:. We listed the first few sums of squares with the
goal of finding a formula by inspection: 1, 5, 14, 30. With the hope that a
formula would involve some product of terms, we proceeded with a slightly
wild approach (although tame from the perspective of someone who already
knows the formula: cf. [9]) of multiplying each term by 6 to introduce more
factors: 6, 30, 84, 180. Next, we factored the first four terms as follows: 1(2)3,
2(3)5, 3(4)7, 4(5)9. From here, we could guess the pattern of n(n+1)(2n+1),
and divided by 6 to undo our initial multiplication.
Proof with PMI:. The formula holds for n = 1 since 1 = 1(1 + 1)(2 + 1)/6.
Assuming the formula holds for the first k naturals, observe that adding
(k + 1)2 yields k(k + 1)(2k + 1)/6 + (k + 1)2 , which can be rewritten as
(k + 1)((k + 1) + 1)(2(k + 1) + 1)/6 as desired. QED.
Students completing their first proofs by induction often respond with uncertainty as to whether they have shown anything at all. In each of the
number-theoretical examples above, the pre-PMI exploration allowed students to engage with the material using authentic mathematical habits of
mind [7], whereas the PMI proofs were initially perceived as an application
of legerdemain. The same can be said of other explorations when compared
with PMI proofs; for example, combinatorial arguments to show {1, . . . , n}
has 2n subsets or that an n-gon where n ≥ 3 has n(n − 3)/2 diagonals may
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position students to participate in mathematical creativity, whereas the corresponding proofs by induction can look stale or procedural, and lack the
aha insight familiar to writings on mathematical creativity (e.g., [24]; see
also [37]).
Our goal, therefore, was to locate a statement whose exploration could be
done with recursive reasoning, in a manner that would allow students to feel
that induction is a natural strategy to justify the assertion. We found such an
example in the writing of Golomb [12]; it is a problem that was popularized
by Gardner [10], visualized by Nelsen [23], and extended by Starr [35] and
Costello [5]. The original phrasing by Golomb (see also [22]) is as follows:
It is impossible to cover an 8 × 8 board entirely with trominoes,
polyominoes of 3 squares, because 64 is not divisible by 3. Instead, it shall be asked: Can the 8 × 8 board be covered with 21
trominoes and 1 monomino (a single square)? [12, page 20]
In this particular excerpt, Golomb is talking about trominoes that look like
extended dominoes with three unit squares in a row rather than two. He
demonstrates that this is only possible when the monomino is placed in
one of four different locations, and then begins his discussion of L-shaped
trominoes:
When another type of tromino is considered, the result is surprisingly different: No matter where on the checkerboard a monomino
is placed, the remaining squares always can be covered with 21
right trominoes, i.e., L-shaped trominoes. [12, page 21].
Our class endeavored to prove the latter statement by using Pólya’s generalization heuristic [25] and, in particular, proving that for all natural numbers
n, a board with dimensions 2n × 2n can be tiled with one monomino and
the rest being L-trominoes. The standard checkerboard result then follows
in the case of n = 3, since it has dimensions 23 × 23 , i.e., 8 × 8. To prove this
by induction, we considered n = 1 and showed any 2 × 2 board can be tiled
with a monomino and an L-tromino. For the 4 × 4 board, we subdivided it
into four 2 × 2 boards, and supposed the monimino was placed in any one
of the quadrants; we could then place a single L-tromino so as to cover one
square in each of the other three quadrants, whence the problem reduces to
solving four copies of the 2 × 2 case. We reasoned similarly for the 8 × 8
board: subdividing into four 4 × 4 boards, placing the monomino in one of
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the quadrants, and placing an L-tromino so as to cover one square in each
of the other three quadrants. The inductive step is summarized elegantly in
Nelsen’s proof without words [23] described in Figure 3:

Figure 3: Inductive step for tiling a 2n × 2n board with a monomino and L-trominoes.

Although we could effectively go through examples of this result by drawing
2n × 2n boards by hand, we wished to create a physical copy (cf. [35]; see
also Figures 1 and 2) that would allow students to operate with the boards
in a manner intended both to (re)humanize [18] the inductive exploration at
hand and to satisfy the need for play in mathematics [36]. Fortunately, our
institution has access to an Innovation Lab in which this was possible.
3. INDUCTION IN THE INNOVATION LABORATORY
In this section, the second author provides further insights and background
on how the project developed across its first two years of implementation.
We also provide pointers to Appendix A, which contains the handout used
by students to begin the project.
Hands On Process Over Three Classes
The students visited the Innovation Lab, which houses a laser cutting machine, to make their own L-tromino boards and pieces over three class periods. They created their graphic designs using Adobe Illustrator software.
Adobe Illustrator vector graphics created instructions for our 30 Watt Universal laser cutting machine by means of color and line thickness.
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Figure 4: A student-created 8 × 8 L-tromino board with a single monomino in the top-left
corner.

Any graphic designs in black were etched on the surface of the material placed
in the machine. Any line shape in red with a hairline thickness (0.001 pt)
was set to cut all the way through the material. Any line shape in blue with
a hairline thickness was set to score the shape in the surface of the material,
following the precise path of the line graphic. Eight-inch square plywood
boards were prepared ahead of time with an inset pocket for the L-tromino
pieces to be cut from acrylic plastic in colors chosen by the students.
Students followed a handout (Appendix A) that guided them with text and
illustrations through three stages of making their designs. Beginning with
their own copy of a template Illustrator file that had been prepared ahead
of time to have pre-drawn grid guidelines for the 8 × 8 rows and columns,
and with an artboard size set to the cutting dimensions of the laser cutting machine (in our case 24 inches by 12 inches), students first created
red lines to mark out their L-tromino shapes and one monomino shape.
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They then created a grid of blue score lines and any black graphics or text
that they wanted to be etched into the inset pocket of their board. Finally
they created any black graphics or text that they wanted to be etched on
the border of their board. These graphics were created on three different
layers in the Illustrator document, as each layer had to be sent separately
to the laser cutter; the first to cut acrylic pieces, the second to score and
etch the inset pocket, and the third to etch the border of the board, which
was at a different material height and thus could not be done at the same
time as the inset pocket graphics. As students began completing the first
stage of their designs the laser cutter could begin cutting their acrylic pieces,
and students could individually choose what color acrylic they wanted to
use, sometimes choosing a different color for the monomino piece to create a
contrast between this piece and the L-tromino pieces.
While the laser cutter cut the acrylic pieces quickly, it took significantly
more time to etch the graphics onto the boards — from 15 to 20 minutes
each — so most of the students’ board designs were etched outside of class
time. Fortunately, they were present while at least one of the boards was
being etched so that they could witness the seeming magic of laser etching
and appreciate the process by which their designs were “printed” onto wood.
The experience of witnessing the laser cutter in action helped demystify and
make more accessible what the machine does and helped them to see its
function as a part of the creative process rather than as an invisible service
that they were using.
Procedural Modifications Across Two Years
A central concern in designing the learning environment for an integrated
technology project is maintaining a balance between time spent learning
and practicing discrete technology skills with time spent exploring and playing with creative ideas relevant to the non-technology learning domain, in
this case mathematics. Upon reflecting on the students’ first year experiences with the project it was apparent to the instructors that students were
confused with the initial document set up tasks, especially with creating
the sixteen 22 mm-spaced horizontal and vertical grid guides used to enable
the precise placement of their L-tromino cutting lines. Students were confused to the degree that some were experiencing a lot of stress by the time
they were able to begin designing their own version of the L-tromino board.
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Figure 5: Students watching the laser cutting machine cut L-tromino pieces.

The instructors noticed students producing relatively simple board designs
despite the examples that they were given showing checkerboard designs and
border enhancements. When encouraged to explore more possibilities some
students declined the opportunity.
The second time around some initial steps were removed from the students’
work time by providing students with a template Illustrator file with the
initial document settings and 16 grid guide tasks already completed. This
allowed students to skip the first page and first instruction on the second
page of the handout and jump right into designing their own L-tromino and
monomino shape cut lines. Allowing students to begin the project designing their own pieces without having to start with tedious tasks that require
precision resulted in students having more attention and cognitive resources
to explore their own graphic ideas for designing their boards. In one case a
student took on the ambitious project of doubling the mathematical dimensions of the grid for her tromino board to make a 16 × 16 L-tromino board
and pieces. Comparing the completed projects from the first year to the
second year, we observed a notable increase in the amount of personalization
students managed to include in their games in the second year (Figure 6).
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Figure 6: Typical board designs from 1st year (left) and 2nd year (right).

Modifications in Process
The first time the instructors embarked on this project the educational technologist was just familiarizing himself with many of the digital fabrication
tools in the Innovation Lab. After the first iteration of the project, he was
able to make one important modification in the process of preparing materials for the project for the second year. In the first year, he prepared the
boards by sawing 8-inch square pieces of 1/4-inch plywood, then using a Carvey CNC milling machine to mill the pockets in which the tromino pieces
would be placed. This took a long time: about 45 minutes for each of the 8
boards. And because the pockets were milled with a 1/8-inch milling bit the
pocket corners were rounded to the nearest 1/8-inch, which required chiseling
out for the trominoes to fit. The second year, a colleague made the helpful suggestion of using the laser cutter to cut the puzzle frames in 1/8-inch
plywood and glue them to 8-inch laser cut square backing pieces, creating
the same pocket frame in a much shorter time, with the added benefit of
perfectly square corners.
4. PARTICIPATING IN CREATIVITY
In making the case that the project at hand facilitates participation in creativity, let us first recall the definition for creativity that we provided in an
earlier section:
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Figure 7: Two student-created 8 × 8 L-tromino boards from the second iteration of the
project.

Creativity: Purposeful work that is novel and valued within a
domain/area, which emerges over time through the participation
of many actors in many roles.
We discuss the project here as being located within the domain/area of mathematics, even as it clearly touches upon other areas (e.g., crafts, design,
technology) and acknowledge that while we consider creativity as domainspecific (i.e., consider participation in mathematical creativity rather than
in creativity writ large) there is an ongoing debate around domain specificity (see, e.g., [1]). Moreover, we reiterate that our notions of valued and
novel are primarily with respect to students’ own self-assessments, and are
not a direct function of evaluations by members of a larger set of eminent
mathematicians or mathematics educators.
Student Participation
Let us take this opportunity to bring in a few student voices around their
participation in this project. The excerpts below were taken from writing
completed just after the boards were created in year two of this project, and
with all students asked to connect the project with Su’s mention of play in
Mathematics for Human Flourishing [36]:

Benjamin Dickman and Erik Nauman

student 1: Making my tromino [board] was an enjoyable mathematical process because there were no great stakes involved in the
task, and the project allowed me to use my imagination and creativity. We were given a lot of freedom within our instructions to
design our tromino boards however we wanted. I found that actually having to create the tromino and monomino pieces for the
board helped me get a better understanding of how to arrange
them because we had to create the pieces from a blank square and
maneuver them so that they all fit onto the board. I really enjoy
doing puzzles and showing other people how to solve puzzles and
I cannot wait to show my tromino board to my family and have
them try and figure it out.
student 2: I really enjoyed making my tromino board and for me it
can definitely fall under the PLAY section in [Su’s] article. The
article explains that play needs to be both fun and voluntary.
The tromino boards that we made to me were definitely fun and
creative. They were also voluntary because we all had the option
to take this class and I know that I would have liked to make
this board whether it was for a class or not. The article also
says that to be categorized as play there is also some structure.
There was structure in what we did because we had the directions that [Mr. Nauman, the educational technologist] gave us
and [Mr. Dickman, the mathematics instructor] explained to us
[in terms of] what we were doing and why it was possible. This
project . . . built community both inside our classroom and out
as we shared these boards with friends and family . . . I really
loved this project and I look forward to what is to come with
more PLAY in our math class.
student 3: I really enjoyed creating my L-Tromino board because it
gave me a chance to creatively create my own personalized board
game. It also gave me a chance to think more closely about patterns and shapes and how games with shapes and patterns are
created. Like Su describes, math is “play,” and when you are
“playing” with math you have both structure, by the concepts
we learn in math, and its rules, but also freedom because you can
experiment with those rules and patterns as much as you like.
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It also [leads] you to use your mind and imagination to apply
things that you know and learn and “play” with it your own way.
I felt like I had the chance to do that with my tromino board,
for I was able to take the patterns and concepts we had learned
and discussed in class, and apply [them] to create my own way of
making and seeing the pattern.
The three sample responses above each use the word “creativity” or “creative” despite the word not arising in their original prompt; the same is true
of “enjoyed” or “enjoyable”. Other themes include a desire to engage with
their families around this mathematical object/idea (e.g., Student 2 writes
that the project “built community both inside our classroom and out as we
shared these boards with friends and family”); freedom (Students 1 and 3
explicitly use this word, and Student 2 writes that the project was “voluntary. . . and I know that I would have liked to make this board whether it
was for a class or not”) despite instructions and structure; and ownership
(each student refers to it as “my” board, and a number of students chose
to personalize them in ways that included meaningful motifs from their own
lives, and the optional addition of their initials, names, and nicknames). We
believe that these selected responses, which have not been anomalous among
all student responses, indicate a clear valuing of their own work.

Figure 8: A student-created 8 × 8 L-tromino board.
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As to novelty, the students are learning a mathematical idea that is new to
them, and for which the board can provide a way of more deeply understanding the underlying structure (e.g., Student 1: “I found that actually having
to create the tromino and monomino pieces for the board helped me get a
better understanding of how to arrange them because we had to create the
pieces from a blank square and maneuver them so that they all fit onto the
board”). Students were new to proofs by induction; new to this construction;
and, in some cases, new to using some of the available tools (digital design
programs as well as the laser cutter). This novelty was furthered as students
personalized their boards in different ways: In the first year of the project,
students created border designs that may have included their name and other
personal flourishes (e.g., incorporating foreign language study as in Figure
4); in the second year, students diverged further by modifying the board
itself, and one student (see Figure 9) decided to engage in two additionally
novel ways: first, by creating her own logo in Desmos to laser cut into the
board’s background; second, by applying her structural understanding of the
generalized proof to create a 16 × 16 board and the corresponding pieces.

Figure 9: A student created 16 × 16 L-tromino board with a background logo that she
designed.
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Returning once more to our definition of creativity, it is reasonable to ask
whether this work is purposeful. Our view is that students who enjoy what
they are doing and learning, describe their motivators as intrinsic/voluntary,
and continue to deepen their knowledge of mathematics — both specific
topics such as proof by induction, as well as “look[ing] forward to what is to
come with more PLAY in our math class” — are operating in ways that are
purposeful.
Back in the classroom, students were able to engage with this particular proof
by induction for the third time. The first time had been in explanations that
used our whiteboard; the second time had been in their constructing the
puzzle in the Innovation Lab, as the guidelines for the laser cutter required
students to tile the board; and, finally, they were able to interact with a
physical copy.
Although most student-creators would bring their own boards home, we kept
a few tromino boards in the classroom; these game boards became a mainstay
among mathematical objects that could be played with by any students who
take courses in that particular classroom — generally ranging from grades 7
through 12. On numerous occasions since the first boards were made, these
student creations have allowed younger students, with either scaffolding by
an instructor or a schoolmate, to learn the inductive/recursive approach to
tiling a board with L-trominoes. This has built anticipation among students
around their own opportunity to create mathematical objects in the Innovation Lab in the future, and allowed them to see not only the novelty in
a mathematical puzzle, but also the value ascribed to this object by both
students, who took care to personalize the boards with their own symbols
and names, as well as instructors, as these boards found a permanent home
among a collection of commercial mathematical puzzles gathered together on
a table in the room (see Figures 10 and 11). Finally, the existence of these
boards and the subsequent familiarity with these materials enabled students
to take a hands-on approach to new creative problems that were posed with
polyominoes. For example, The Riddler column at FiveThirtyEight posed
a problem for which we could use our boards but would need to manufacture pentominoes [27]. With the L-tromino foundation, addressing this latter
condition proved to be straightforward, and we were able to laser cut pentominoes for physical game play (see Figure 12) that was featured in The
Riddler write-up [28] that followed a week later.
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Figure 10: A student-created L-tromino board balanced in the top-left on our play table.

5. MATHEMATICAL CODE SWITCHING
We close by responding to the third item of feedback that we sometimes
face when interacting with educators and other stakeholders around fostering
creativity in the (mathematics) classroom. As stated in the introduction, this
item can be paraphrased as follows:
I have heard about some possible ways to engage students mathematically — maybe even creatively — but I am worried that they
would be frowned upon since they do not connect with the ways
that others (e.g., administrators, parents/guardians/caretakers)
think about math.
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Figure 11: Two L-tromino boards located on the instructor desk adjacent to the play
table.

Figure 12: Pentominoes designed for hands-on play with The Riddler puzzle.
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This is a real concern for those who may hear back that they should be
attending more precisely to a preset list of topics, as those are the ones that
are best recognized as being mathematical (e.g., solving equations, measuring
angles). One way that this pushback arises is in the “Where’s the math?”
question, for which Rubel and McCloskey write:
In general, the ‘Where is the math?’ critique is usually used to
signal either that mathematics is not foregrounded enough among
social phenomena or that the mathematics is not rigorous enough.
[29, page 9]
The authors go on to describe further problems with this framing, including a
view suggested by the definite article ‘the’ that there is a singular mathematics at play. We note that, in the particular context described here, there is
also a more specific criticism that could be levied, whereby stakeholders could
ask why, for a course that has Differential Calculus as its pre/corequisite, students are “playing with blocks” rather than pursuing, for example, Integral
Calculus, or a course on Big Data and Statistics, or some other more recognizable presentation of mathematics.
To respond to these potential critiques, we advocate using a strategy for
creative insubordination [17] that we refer to as mathematical code switching (MCS). MCS refers to the use of formal, potentially buzzword-bloated,
mathematical terminology to signal connections between covered material
with areas of mathematics that have been traditionally considered more rigorous. To give a concrete example, one response to the “playing with blocks”
critique could be that our project is enabling students to engage in the recursive thinking that typifies areas of Discrete Mathematics, and allows them
to prove by construction a theorem relying on the Principle of Mathematical Induction — which, itself, is one of the Peano Axioms, over which it
is equivalent to the Well-Ordering Principle. Critical to this description is,
first, that it is true; and, second, that it brings into the discussion a set of
mathematical terms intended to shift away from the language of “blocks”, in
an effort to convince the interlocutor that there are recognizably formal or
rigorous topics at hand.
The idea of MCS is not to establish connections unknown to professional
mathematicians, for whom the notions of playing with mathematics may
already seem manifestly reasonable [36]. Rather, our intention is to wield
mathematical language as one of the master’s tools in the sense of Lorde
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as referenced in Gutiérrez [17]: We are not, by virtue of charging our descriptions with arcane terminology, dismantling a system that privileges formal mathematical language. Instead, we are adhering to prewritten scripts
around what does, or does not, belong in a rigorous mathematics course,
and using a select nomenclature to combat the reductive language (e.g., “the
math” or “playing with blocks”) found in criticisms that, if they are to take
hold, would interfere with our focus on fostering creative participation.
There are, of course, significant limitations to MCS. Beyond its ultimate
inability, per Lorde, to dismantle the master’s house, other potential concerns
arise. We non-exhaustively mention just two potential issues here.
First, we cannot advocate in good faith for the widespread expectation that
others be prepared to engage with MCS in ways that reduce power imbalances. One corollary of using this technique to enable educators to bring in
non-standard material is that those who are unfamiliar with certain terminology — how it is not “just folding paper” but rather exploring non-Abelian
symmetric groups; or how it is not “just playing with cards” but rather
exploring connections between the Euler totient function, the discrete logarithm, binary fraction periods, and Faro shuffles — may find themselves
less able to diverge from the canon of mathematical topics. Our wish is to
empower educators, students, and other stakeholders — including, but not
limited to, administrators — so that pushback can be responded to using
MCS as necessary.
A second corollary is that MCS can be wielded in ways that maintain or exacerbate power imbalances; consider a mathematics instructor who responds
to a student’s concern by choosing to employ MCS in ways that denigrate
that student’s position and dismiss their concerns (e.g., appealing to mathematically unfamiliar ways in which various averages can be computed for a
course grade). Alternatively, administrators may attempt to use a form of
MCS in order to justify a negative evaluation of an instructor’s contribution
to the institution by appealing to Value Added Models or other quantitative
measures that rely on inaccessible mathematical or statistical language.
Second, we would be remiss if we did not mention our own positionality as
white, cishetero-presenting male teachers. There can be no doubt that these
identity factors, among others, allow our divergence from typical curricula to
be perceived more often as creative and innovative rather than inappropriately disruptive or pedagogically insubordinate. Just as we advocate for MCS
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based on the privileging of formal mathematical language, so, too, must we
recognize that our own identities are privileged in ways that make linguistic
shifts a viable tool in combating criticism of our work as educators.
CONCLUSION
In this paper, we have endeavored to explain a single project that the two
authors — a mathematics instructor and an educational technologist — have
designed and modified to foster creative participation among our students.
To do so, we have set forth our own definition and framing of participatory
creativity; we have described the project and showed examples of student
work (and include materials to implement the project in our appendix); and
we have described a technique that we label as mathematical code switching
(MCS) to respond to outside criticisms of our teaching, although it is a
tool that is necessarily imperfect, and an approach around which we hope
to see further discussion and analysis. Nevertheless, we are hopeful that
other educators can draw from our nascent and ongoing experiences with this
particular project, and the evolving language that we use to describe it, in
imagining how to facilitate their own learners’ participation in mathematical
creativity.

Figure 13: A student-created 8 × 8 L-tromino board.
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A. Make a Tromino Game
• Open Illustrator.
• Create a new document.
– The important settings are
600 mm for Width,
– 300 mm for Height,
– and RGB Color for Color
Mode.
• View→Rules→Show Rulers to
turn on rulers.

• Make the border of our trominoes square
– Select the rectangle tool,
hold Shift, and drag a
square out from the corner.
– Each side length should be
176 mm.
– To be precise, click Transform and type in the exact
dimensions.
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• To tell the laser to cut this
shape:
– Make the fill equal to none,
– and make the stroke color
red.
– For now, leave the stroke at
1 pt so that it can be seen.
– (Later, it will be changed to
0.001 pt, which it must be
for the laser to take it as a
cut.)
• Now we need grid lines spaced at
22 mm.
– Drag them out from the
rulers.
– Select each one and click
Transform to type in an exact position.

• Now use the Line Segment tools
to draw the borders of you
monomino and trominoes.
– The shapes can share a border, as the laster only needs
to cut the shared borders
once.
– Select each one and click
Transform to type in an exact position.
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• To see how you are doing, hide
the guides from time to time using View→Guides→Hide Guides
or Command + C.

• When you finish making your
arrangement of trominoes (and
one monomino) drag your mouse
over all of the shapes to select
them.
– Change the stroke to 0.001
pt. (You will not be able to
see your lines but they are
there.)

• Find your Layers palette. If
you do not see it, click Windows→Layers.
– Click the little Post It in
the lower right of the Layer
palette to make a new layer.
– Select Layer 2 but keep
Layer 1 showing so you can
see your guides.
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• Now it is time to make your
board design
– Using your guides, draw a
line across every row and
column.
– Make the stroke blue.
– Keep it at 1 pt size.
– Blue will make the laser
score, and not cut, the
line.

• If you want to can make a
checkerboard with black squares.
– Black will make the laser
etch.

• Now, on Layer 2, add vertical
and horizontal guides at 100 mm
and at 200 mm.
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• This is a tricky part:
– Hide your guides.
– Drag to select all of yor
lines.
– Then show your guides.
– Now move your selected
lines so they are centered
over the crosshairs of the
100 mm guides.
• Beautiful!
• Now add a 3rd Layer!
– This will be for any decoration you wish to make
around the margin of your
board.
– Anything in the margin
should fit between your
lines and the border.
• You could put text.
– If you do text, when you are
done click Type→Create
Outlines to turn the text
into shapes.
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• If you use an image from the web
it should be black and white.
– Download it.
– Click File→Place and select
the file.
– Rotate and resize your image border until you like it.
– Click Image Trace to make
it into a vector graphic.
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• Last step!
– Click back on your Layer 2.
– Hide Layer 3.
– With your lines selected,
change their stroke size to
0.001 pt.
Now save your file. Upload it to your team drive folder. It is ready for the
laser!

